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 Presentation

Welcome to NeoDraw version 2.    This powerful, yet easy-to-use package is designed for graphical and 
technical drawing tasks. NeoDraw is a vector-based drawing application which can be run under 
Windows 3.1, 3.1x and Windows 95.

Trial copies of NeoDraw are available from our BBS, Web site, and from major on-line services worldwide. 
These allow you to evaluate NeoDraw, before you purchase it, to see if it fits your needs.

NeoDraw helps with a wide variety of drawing needs:

• you may draw rectangles, squares, ellipses, circles, single lines and broken lines, cubic and 
quadratic splines and Bezier curves, arcs, stars...

• Text may be placed in your drawing using TrueType, Atm or other Windows fonts. NeoDraw also 
provides special, distortable fonts.

• You can import bitmap images or metafile objects originating other programs. NeoDraw objects may 
also be placed onto the Windows clipboard as bitmap or metafile objects.

• Objects you create can be sized, moved, grouped, deleted, modified, aligned, rotated or flipped, 
skewed, distorted (using lens projection, warp, etc.), and more.

• Objects may be placed on and moved to different drawing layers

• Grids, guidelines and zoom allow you to draw more precisely.

• Many clipart pictures can be obtained from the Clipart library (included in the full version).

You may allow your friends to try NeoDraw. Evaluation copies of NeoDraw are available from our BBS 
and Web sites at no charge. (Disk vendors may charge a small fee to cover their costs for distribution. 
Please contact us for permission to distribute commercially).

Registration fee is $49.95. For this price you get a user manual, license, the latest version of NeoDraw, 
complete on-line, 25 fonts, 2,000 clipart pictures, access to special pricing for upgrades, and other 
benefits. For more information, see the Why to register help topic.

Print registration form from print command of file menu of the help menu.

When you register, you will enable us to improve and add new features to this product!



Trial Copies

NeoDraw may be evaluated for up to 30 days. If you wish to continue to use NeoDraw 
after 30 days, you must purchase a registered copy of NeoDraw from NeoSoft Corp. 
Registered users receive a manual, license, the latest version of NeoDraw, extra fonts 
and more than 2 000 clipart pictures.

Once you have received NeoDraw, simply type the serial number (found on the top of 
the card enclosed with your manual) into the space provided on NeoDraw's Register 
Screen. Type in your name in the space below the serial number. And be sure to send 
the completed bottom half of the Product Registration Card to NeoSoft Corp. so that we 
can inform you of any updates to the software. Keep the top half of the card in a safe 
place in case you ever need to reinstall NeoDraw.

Why you must register
Registration form



Why you must register 

When you register you help us to provide you with newer and better versions.

All registered users will receive:
• a license.
• 25 vector fonts.
• a library containing more than 2,000 clipart pictures.
• a manual.
• removal of the following evaluation version features

- reminder screens when loading, saving, using Split text command, or exiting.
- buttons of the Print dialog box which are disabled after the expiration of the 

evaluation period.
- limitation to only one undo level available - up to nine (Preferences dialog).
- disabled saving of Toolbar set up.
- disabled Copy and Cut for metafile version of selected objects in the clipboard.
- message "This is an unregistered version" when using Fit on screen command 

(Zoom menu).

You may order by payment with check in U.S. funds or major credit card.

354 NE Greenwood Avenue, Suite 108
Bend, Oregon 97701-4631
Telephone
(541) 389-5489
Fax
(541) 388-8221
BBS
(541) 383-7195
E-Mail
admin@neosoftware.com
Web Site
http://www.neosoftware.com/~neosft/

In France, England and Japan contact:
Bertin et Legalle Logiciels

9, chemin des Vignes de Chappe
18 000 Bourges



Tel. : (+33) 48.20.81.24
Fax : (+33) 48.20.63.51



What's new?

New functions:
 Dimension/Extremities. Dimensions with various extremities (arrow, triangle, lozenge, circle, square), 

localization, scale, etc.
 Postscript export., separation.
 Bitmap import formats available: Bmp (all formats), TGA (compressed or not), PCX (monochrome). All 

import formats (vector or bitmap) drag and drop.
 Customised toolbars.
 Styles: copy and paste a style (all parameters of a drawn object or NeoDraw text such as thickness, 

filled color, font, etc.).
 New Paste Special  dialog allows you to copy and paste a style (all parameters of a drawing or 

NeoDraw text such as thickness, filled color, font, etc.).
 New layers, much easier to use, thanks to a new Layers control window you can leave open.
 Information window giving information about selected elements (you can leave it onscreen too).
 Complete Print dialog box: count copies, scale (overlap), fit on paper, printer type end printer 

configuration, quick printing, centered, name and date of file, etc.
 Zoom menu: zoom on selection, full screen, from 100 to 800 % (with zoom rectangle: from 40 to 1000 

%)...
 In between: number of steps...
 Diffusion tool: diffusion of vector elements (such as circles, triangles, squares) for comet like effects.
 Mask: an attribute to place bitmap or vector elements (drawings, NeoDraw text, tiles, etc.) visible only 

inside a vector element.
 Conversion of NeoDraw text into curves.
 New Palette colors dialog box (Hue, Saturation, Light...).

Main improvements:
 Import HPGL ('.PLT), drag and drop HPGL. dialog box with many options
 Export WMF resizable Aldus format.
 Arrange: Background command to send the selection to the background.
 Consecutive selection with TAB key.
 Selection blocks with horizontal and vertical handles.
 Moving objects with real-time element contour outline.
 Paste a DIB from clipboard.
 Copy gradient into metafile on the clipboard.
 Automatic creation of guidelines.
 Zoom with '+' et '-' keys.
 Moving selection with keyboard (Shift + arrow keys).
 Moving active drawing window with keyboard (Ctrl + arrow keys).
 etc.



Registration form
Print this form with the Print command under the File menu of Help.

Name:              _______________________________________

Company:    _______________________________________

Address:      _______________________________________

                                _______________________________________

                                _______________________________________

Telephone number:            _____________________________

Quantity Total

NeoDraw 2.1 $ 49.95 X ___________ = ___________

Shipping + $5.00/U.S., 
$7.00/Canada/M

exico, 
$12.00/other 

nations

TOTAL = ___________

Make checks payable to:

Neosoft Corp.

You may pay by check or major credit card (American Express, Visa, MasterCard or Discover.

Credit card type___________________________

Credit card number:
_______    _______    _______    _______

Expiration date: ____/____ /____

Date ____/____ /____          Signature :    _________________

Mail to:

Neosoft Corp

354 NE Greenwood Avenue

Suite 108

Bend, Oregon 97701-4631

U.S.A.

or call our Sales Department at: 541-389-5489, or fax this form to 541-388-8221

Suggestions:

________________________________________________

________________________________________________

________________________________________________

Where did you hear about NeoDraw? ______________________________



Windows text editor

File   menu  
Edit   menu  
Search   menu  
Font   menu  
Size   menu  
Style   menu  
Align   menu  

Click on an Icon:

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

open the standard Windows Fonts dialog box.

To open the Windows text editor:
• select text block and press the Control and E keys simultaneously, or click the Text tool with the right 

mouse button.

• A text editor is created for each Windows text block.

See:Create a Windows text block



File menu    Windows text editor

•  Open command: opens a file selector for opening Ascii or Ansi text. Default is Ansi. Ascii text may 
be converted to Ansi.

•  Apply command: aapplies all modifications made in the text editor to the Windows text block 
on your drawing.

•  Letter Spacing command: opens the Letter Spacing dialog, where you may specify the size 
of an area at the top and left side of the text block.

•  Keyboard command: opens the Keyboard accessory.

•  Quit command: closes editor and applies your edits to the text block.



Edit menu    Windows text editor

•  Undo command: cancels your last action.

•  Cut command: deletes selected text and puts a copy into the Clipboard.

•  Copy command: puts a copy of selected text into the Clipboard.

•  Paste command: inserts the text of the Clipboard at the cursor position.

•  Delete command: erases selected text.

• Delete all command: erases all the text.



Search menu    Windows text editor

• Find... command: opens a dialog in which you specify the text to search for.
When the Case Sensitive option is on, NeoDraw differentiates uppercase from lowercase when 
searching.

• Replace... command: opens a dialog box where you may specify the text to found and new text to 
replace it.    Options exist to differentiate uppercase from lowercase when performing a search, to 
replace all occurences and to confirm (or not) each substitution.

•  Next command: repeats the search for the text specified in Find or Replace dialogs.



Fonts menu Windows text editor

Displays, in alphabetical order, available Windows fonts (TrueType,Poscript ATM, etc.)



Size menu    Windows text editor

Displays a choice of character sizes.



Style menu    Windows text editor

• Bold, Italic, Strikeout, Underline commands - separately or simultaneously.

• Normal command: default option. Disable other styles.



Align menu    Windows text editor

Aligns and justifies Windows text.

•  Left command: align text on left.

•  Right command: align text on right.

•  Center command: center text between left and right sides.

• Justify command: align text on left and right.



Clipart

Clipart consists of predefined graphic elements.

Clipart is contained in files with '.TEO' extension (you may also access clipart using the Open command 
of the File menu).

The Clip-Art dialog may be accessed with the Clipart... command of the File menu, allowing easy 
browsing through the clipart library.

Clipart elements are grouped.
Use the Separate command (Ctrl + S) to select and modify individual elements.



Glossary

Approach
Attributes

Bitmap
Block control points

Drawing path
Duplicate

Element

Gradient angle
Grid
Group
Guideline

Path control point

Rulers

Status line
Style

NeoDraw Text

Windows Text



Drive Surface

Drive Surface (program Drvsurf.exe) is a surface editor.

These surfaces can be pasted into NeoDraw.

To improve surfaces (color, gradient...) use Edit Drive Surface from Attributes popup menu opening 
Bezier surface dialog box.

Drvsurf.exe has its own help menu (?).



Shortcuts

Keystroke(s) Action

Ctrl + N Creates a new drawing.
Ctrl + O Opens a drawing file.
Ctrl + S Save changes to the active drawing.
Ctrl + K Opens the Clip-Art dialog window.
Ctrl + T Opens the Template dialog box.
Ctrl + P Prints the active drawing.
Ctrl + X Duplicates selected object(s).
Ctrl + A Selects all objects in the active layer of the active drawing.
Ctrl + G Groups selected objects in a single object.
Ctrl + V Activates the Tile Object command of the Modify menu
Ctrl + U Ungroups a selected group.
Ctrl + E Activates the Edit command of the Modify menu.
Ctrl + I Opens the Info window.

+ Zooms in
- Zooms out.
/ Zooms in on the selected object(s).
* Displays the entire drawing.

F8 Displays the visible part of the active drawing on the whole screen (Full 
screen command of the Zoom menu.

F9 Displays either the most important part of the drawing, (if possible, the entire 
drawing) or zooms to a 100% rate

Alt+BkSp Undoes
Shift + Alt + BkSp Redoes
Del Deletes
Shift + Del Cuts selected object(s) and places onto the clipboard.
Ctrl + Ins Copies selected objects to the clipboard.
Shift + Ins Pastes a copy of the clipboard contents into the active drawing window.
Shift + Ctrl + Ins Opens the Paste Special dialog.

Ctrl + Shift + R Moves the selected object(s) to the background.
Ctrl + Shift + D MMoves the selected object(s) up one level (same as Above 

command).
Ctrl + Shift + E Moves the selected object(s) back one level (same asBelow 

command).
Ctrl + Shift + P Moves the selected object(s) to the foreground.

Ctrl + Shift + V Flips selected objects in verticalsymmetry.
Ctrl + Shift + H Flips selected objects in horizontalsymmetry.

Ctrl + Shift + A Assembles selected objects into a single object.
Ctrl + Shift + S Disassembles an element previously assembled.

Ctrl + Shift + G Opens the Grid dialog box.
Ctrl + Shift + T Opens the Preferences dialog box.



Left arrow Moves the drawing to the right.
Right arrow Moves the drawing to the left.
Top arrow Moves the drawing downward.
Bottom arrow Moves the drawing upwards.

Shift + Left arrow Moves the selection to the left according to the magnetic grid 
spacing.

Shift + Right arrow Moves the selection to the right according to the magnetic grid 
spacing.

Shift + Top arrow Moves the selection upwards according to the magnetic grid 
spacing.

Shift + Bottom arrow Moves the selection downward according to the magnetic grid 
spacing.

Ctrl + Shift + 0 .. 9 Stores zoom rate and scroll bar position into memory.
Ctrl + 0 .. 9 Retrieves zoom rate and scroll bar position from memory.

    note: 0..9 keys must be activated on the upper part of 
keyboard.

Tab Consecutively selects elements according to their display order.
Shift + Tab Selects elements according to the reverse order of display.

Shift + F5 Stacks drawing windows.
Shift + F4 Organizes the display with tiled drawing windows, so they do not 

cover each other.

Shift + F1 Opens NeoDraw's Help module.
F1 Activates the context-sensitive help cursor.

TOOLS
a, A, 7 Text.
z, Z, 8 Zoom.
e, E, 9 Arrow selector.
q, Q, 4 Ellipse.
s, S, 5 Rectangle.
d, D, 6 Rounded rectangle.
w, W, 1 Arc.
x, X, 2 Line.
c, C, 3 Cubic spline.
0 (zero) Star.



Configuring NeoDraw with NeoDraw.ini

[NeoDraw]
Coordinates=Yes

Indicates, Yes or No, whether mouse position coordinates are dispalayed on the status line.
Compression=No

Indicates, Yes or No, whether the NeoDraw files are saved in compressed mode.
Bitmap=Yes

Indicates, Yes or No, whether NeoDraw puts a bitmap version of the object into the clipboard when 
using the Copy or Cut command of the Edit menu.

Image=Yes
Indicates, Yes or No, whether NeoDraw puts a metafile version of the object into the clipboard when 
using Copy or Cut from the Edit menu.

Palette=No
Indicates, Yes or No, whether the floating palette is displayed when launching NeoDraw.

Backup copy=Yes
Indicates, Yes or No, whether NeoDraw writes a backup copy (with ".TBK file extension) when using 
the Save command of the File menu.

Selectors31=Yes
Indicates, Yes or No, whether NeoDraw uses the standard Windows file selector.

Control points in color=Yes
Displays Control drawing points in colors, according to the type of point:

line points in blue
arc points in green
spline points in red...

Fast gradient=Yes
Displays (only on screen) the gradients in a fast mode (with a limited number of bands).

Move full shape=Yes
The outline of objects are visible while being moved.

Save Metafile=Yes
NeoDraw saves a metafile version (with ".WMF" file extension) when using the Save or Save as... 
command of the File menu.

Color palette=Yes
The active color palette is saved with the drawing.

Rulers=Yes
Indicates, Yes or No, whether the rulers are displayed.

Undo levels number=3
The three last operations may be canceled (you may use a number from 0 to 9).

Coordinates Inch=No
Indicates, Yes or No, whether the unit of the coordinates on the status line are in inches (or in mm).

Rulers Inch=No
Indicates, Yes or No, whether to use inches as the unit for the rulers (or to use mm).

Grid Inch=No
Indicates, Yes or No, whether to use inches as the unit for specifying grids (or to use mm).

Palette 256=No
Indicates, Yes or No, whether NeoDraw uses a palette with only pure colors (see Preferences).

Fixed Palette=Yes
Indicates, Yes or No, whether the fixed palette is displayed when launching of NeoDraw (see 
Preferences).

Info Bubble=No
Indicates, Yes or No, whether Info Bubbles are displayed when the mouse moves over toolbars.

Bel Icones activated=Yes
Indicates, Yes or No, whether toolbars are displayed (by activating Active option in the Iconbars 
configuration dialog.



Blue frame=Yes
Indicates, Yes or No, whether NeoDraw displays a blue frame around the page (see Preferences).

Progression=Yes
Indicates, Yes or No, whether NeoDraw displays progress bars on the bottom of the screen to indicate 
the program is working (see Preferences).

Large palette=Yes
Indicates, Yes or No, whether NeoDraw displays a big palette window (see (see Preferences).. 

Large tools=Yes
Indicates, Yes or No, whether NeoDraw displays a large toolbox window (see Preferences).. 

Small Ctrl Pt=Yes
Indicates, Yes or No, whether the objects inside a group display small points at their corners (see 
Preferences).

With Rectangle=No
Indicates, Yes or No, whether each object displays a rectangle when moving (see Preferences).

Big Icon=No
Indicates, Yes or No, whether the Iconbars are displayed using large icons (Big option in the    
Iconbars configuration dialog box.).

Frame Win Rect=Yes
Indicates, Yes or No, whether a frame is displayed around the Windows text blocks when not 
selected. If No, the frames are not displayed.

[Directory]
Fonts=C:\NEODRAW

Indicates the directory containing NeoDraw's fonts (extension: ".FW").
Help=C:\NEODRAW

Indicates the directory containing NeoDraw's help file: NeoDraw.hlp.
Teo=C:\NEODRAW\TEO

Indicates the directory in which a NeoDraw drawing file ("*.TEO") was last opened or saved using the 
Open, Save or Save as...commands in the File menu before quitting NeoDraw.

Dc=C:\NEODRAW\DC
Indicates the directory of the clipart library file (DC.DC).

BMP=C:\NEODRAW\BITMAP
Indicates the directory where an exported bitmap file ("*.BMP") was stored when the Export|Image 
BMP or    Import|Image BMP commands of the Filemenu. This is the directory the File Selector will 
use when next using these commands.

PLT=C:\NEODRAW\PLT
Indicates the directory where an exported HPGL file ("*.PLT") was stored when the Export|Ploter 
HPGL or    Import|Ploter HPGL commands of Filemenu were last used. The File selector will use this 
directory next time you use these commands.

PS=C:\NEODRAW\FLASH
Indicates the directory where an exported Postscript file ("*.PS") was stored when the Export|
Postscript PS... command of the File menu was last used. The File selector will use this directory 
next time you use this command.

TXT=C:\NEODRAW
Indicates the directory where an imported Text file (".TXT") was obtained when Import|Script TXT 
command of the File menu was last used. The File selector will propose this directory next time you 
use this command.

WMF=C:\NEODRAW
Indicates the directory where a WMF file (Export|Vector WMF or Import|Vector WMF) was stored or 
found the last time these commands were used. The File selector will propose this directory when you 
next use these commands.

TGA=C:\NEODRAW
Indicates the directory where an imported bitmap file ("*.TGA") was obtained when Import|Image... 
TGA commands of the File menu was last used. File selectors will propose this directory when next 



using this command.
PCX=C:\NEODRAW

Indicates the directory where an imported bitmap file ("*.PCX") was obtained when Import|Image PCX 
command of the File menu was last used. File selectors will propose this directory when you next use 
the command.

[Grid]
Visible=Yes

Indicates whether, Yes or No, the Visual grid is visible.
Active=No

Indicates whether, Yes or No, snap to Magnetic grid is active
Visual step X=10

Indicates the X step for the Visual grid.
Visual step Y=10

Indicates the Y step for the Visual grid.
Magnetic step X=1

Indicates the X step for the Magnetic grid.
Magnetic step Y=1

Indicates the Y step for the Magnetic grid.

[Program]
To launch external programs from the NeoDraw Options menu.

E.g.:
1=&Drive Surface..., c:\windows\NeoDraw\Bzsurfac.exe
2=&ClipBoard..., c:\windows\Clipbrd.exe
3=&NeoPaint..., c:\neopaint\neopaint.pif
4=&NeoDraw.Ini..., c:\windows\Notepad.exe c:\windows\NeoDraw.ini

[Files]
NB=6

Number of filenames listed under the File menu (see 1, 2, 3 .. File name).
Max=6

Maximum number of previously opened files listed under the File menu.
1=c:\NeoDraw\demos\bip.teo
2=c:\NeoDraw\etiquette\etiq_4d5.teo
... Filenames to open

[Config Page]
Contains the setup parameters of the Page configuration... dialog.
Size=7

Page format is "US Letter":
1 - A5: 148 X 210
2 - A4: 210 X 297
3 - A3: 297 X 420
4 - B5: 182 X 257
5 - B4: 250 X 353
6 - Tabloid: 279.4 X 431.8 (11"x17")
7 - US Letter: 215.9 X 279.4 (8.5"x11")
8 - US Legal: 215.9 X 355.6 (11"x14")

Orientation=1
Page orientation is Portrait.



2 - Landscape
Color=16777215

Indicates the color of the paper (not printed).
Other X=210

Indicates the X page size.
Other Y=297

Indicates the Y page size.

[Bitmap]
Configures the sub-menu opened from the Edit bitmap command of the popup attributes menu.
Nb=2

The number of programs.
1=PBRUSH.EXE
2=c:\windows\graphy\psp\psp.exe
... names of the programs to launch.

[Line]
Saves parameters for the Line thickness dialog (accessed from the Preferences dialog).

[HPGL]
0=7
Indicates that all the options of the HPGL Import dialog box are checked (0=0: all options unchecked).
1=0,1
2=16711680,2
3=255,4
4=65280,1
5=128,1
6=8421504,1
7=12632256,1
8=8388608,1
Number of plotter= RGB decimal color conversion,line thickness

[Templates]
NB=4
Max=6
1=C:\NeoDraw\demo\bulletin.teo
2=C:\NeoDraw\demo\beacholy.teo
3=C:\NeoDraw\demo\sophie.teo
4=C:\NeoDraw\demo\victori.teo



 Toolbars

Most NeoDraw menu commands may be accessed from icon buttons.

File Menu

New

Open...

Save

Save as

Clipart...

Template...

Plotter... HPGL

Image... PCX

Image... BMP

Image... TGA

Vector ... WMF

Vector ... WMF

Plotter... HPGL

Image... BMP

Postscript...PS

Print...

Control panel...

Exit

Edit  menu

Undo

Redo

Delete

Cut

Copy

Paste

Duplicate

Copy style

Paste style

Select all



Modify menu

Group

Object Tile

Ungroup

Edit

Information...

Background

Above

Below

Foreground

Top

Bottom

Right

Left

Center horizontal

Center Vertical

Horizontal symmetry

Vertical symmetry

Assemble

Disassemble

Warp

Blend shapes...

Options menu 

Grid...

Page configuration...

Preferences...

Color palette

Rulers

Toolbars

Quick display

Display bitmap

Attributes menu

NeoDraw text...

Drawing...



Dimension...

Color...

Gradient...

Keyboard...

Layers...

Zoom menu 

Fit on screen

On selection

Windows menu

Cascade

Tile

Close all

? menu 

Context sensitive help

Others:

Applies a predefined line thicknesses (set with Line under the Preferences dialog).
Applies a thickness=0 to selected object outline(s).

Text editor

Open... command    File menu

Apply command File menu

Lettering...command    File menu

Keyboard...command File menu

 Quit command    File menu

Undo command    Edit menu

Cut command Edit menu

Copy command    Edit menu

Paste command    Edit menu

Delete command    Edit menu

Find... command    Search menu



Next command Search menu

opens the standard Windows Font dialog.

Left command    Align menu

Right command    Align menu

Center command    Align menu

Justify command Align menu



Tools box

The toolbox contains tools for drawing, editing text, deforming objects, zooming, etc.
This box can be place anywhere on the screen.

      Text

      Zoom

      Arrow

      Ellipse

      Rectangle

      Rounded rectangle

      Arc

      Line

      Cubic spline

      Stars

      Quadratic spline

      Bezier

      Rotation

      Lens Projection

      Skew

      Comet

      Scissors

      Stamp Pad

Common properties of drawing tools

      Origin



Text tool Text 

Keyboard shortcuts: 'a', 'A', '7'.

Allows you to place text into the active drawing window.

NeoDraw allows you to create two different kinds of text:NeoDraw text uses special, distortable vector 
fonts which are ideal for producing titles and other special text. Windows text is used for larger text 
blocks using Windows' fonts (such as TrueType, ATM, etc.).

To create NeoDraw text.

To create a Windows text block.

To modify NeoDraw text attributes

To modify Windows text attributes

Note: Windows text objects may be easily recognized on the screen by their rectangular dotted lines.



To create NeoDraw text

Two methods:
*1 - the direct addition into the drawing window:

• Activate the Text tool .
• Click with the left mouse button on the desired starting position: a cursor appears (the size of this 
cursor is proportional to the size of the active font.
• Type in your text.

*2 - using a text editor:

• Click on the Text tool .
• Click with the left mouse button at the position you want the text begin.
• Press the Ctrl and E keys simultaneously,
• or activate the Edit command from the Modify menu or from the popup Attributes menu.,
• or click on the Text tool using the right mouse button,
• Type in your text.

To edit a previously created NeoDraw object:
• Select the text.
• Simultaneously press the Ctrl and E keys, or activate the Edit command of Modify menu, or click 

with the right mouse button on the Text tool.
• Modify the text.

The text is displayed with the active font and attributes. To change the font or the text attributes, use the 
NeoDraw Text... command of Attributes menu or popup Attributes menu.
The font may also be changed using the Font command of popup Attributes menu.

Use the Keyboard accessory to edit and/or to search for a particular character in a font.



To create Windows text block 

• Activate Text tool 
• Press the Ctrl key and drag out a rectangle to contain the text. NeoDraw will then open the 
Windows text editor.
• Type in your text.
• Select attributes (size, style, font, etc.).
• Select the Apply command from the File menu of the Windows text editor.

Note 1: the Transparent option in the Drawing... dialog allows text to be displayed with no background.

Note 2: the text block may sometimes display small defects on screen. This does not affect printing.

To modify a Windows text block:
• Select a Windows text block.
• Simultaneously press the Ctrl and E keys,
• or activate the Edit command in the Modify menu or from the popup Attributes menu.,
• or click with the right mouse button on the Text tool,
• Edit the text and its attributes in the Windowss text editor.

Note: several Windows text editors may be open simultaneously.



Zoom tool 

Keyboard shortcuts: 'z', 'Z', '8'.

The Zoom tool allows you to work with an enlarged or reduced display of your drawings.

Zoom menu allows you to display the entire drawing (if possible), to zoom on a selected object, to zoom 
by 100% increments, or to display the drawing on the entire screen.

Whatever the rate of zoom, all NeoDraw tools and functions are available.

To zoom in on a part of the drawing:
• Activate the zoom tool (click with left mouse button)
• Drag a rectangle around the area to be enlarged.
• Release the mouse button.

You may also use the '+' and '-' keys to zoom in and to zoom out.

To display the drawing at its actual size (zoom=100%) or to come back to the default zoom::
• Click on the Zoom tool using the right mouse button.
or
• Activate F9 key.

Note: the maximum rate for the zoom is 1000 %, the minimum rate is 40 %.



To select objects 

To select a single object:
• Use the Arrow tool (click with the left mouse button).
• Click on an object.

To select several objects:
• Click on each of the elements desired while holding the Shift key down.
or:
• Click on the Arrow tool.
• Drag a rectangle around the objects to select.

Notes: when one or several elements are selected:
1 NeoDraw displays, at the four corners and on the sides of the selection, block control points allowing 

the objects to be distorted or resized.
2 When a single element is selected path control points also appear. These path control points can be 

moved or deleted (Del key). New control points of different types (line, arc, spline...) may be inserted 
seeTo Modify the outline of an element).

3 the Tab key allows you to consecutively select elements according to their order of display. To select 
consecutive elements in reverse order, press the Tab and Shift keys at the same time.



To move objects 

To move objects with the mouse:
• Select one or several objects.
• Hold down the left mouse button while dragging the selection to the desired position.
Note: while dragging, the objects display their outline. To display only a rectangle containing the 

selection while moving, activate the left and right mouse buttons simultaneously. To reverse this 
function, enable the Fast move checkbox in the Preferences dialog.

To move objects using the keyboard:
• Select one or several objects.
• Hold down the Shift key while pressing an arrow key (top, bottom, right or left).
• The movement will correspond to the spacing set for the magnetic grid.

To move the drawing inside the window using the keyboard:
• Hold down the Ctrl key down while pressing an arrow key (top, bottom, right or left).

Note: it is also possible to move an object from one drawing to another open drawing. Simply drag the 
selected object onto another open drawing window. To move several objects you must first group 
them.



To enlarge and to reduce of objects 

• Select one or several objects or groups.
• Click with the left mouse button on one of the block control points, and drag the mouse.
• Release the mouse button.

To resize the object(s) proportionally:
• Proceed as explained above, but use both left and right mouse buttons.
• Release the mouse buttons (left one first).

Other distortions:
 Warp distortion
 Symmetry
 Rotation
 Skew tool
 Lens projections



To delete objects 

• Select one or several objects or groups.
• Activate the Delete key or the Delete command of the Edit menu.



To modify the outline of drawing objects 

To move path control points:
• Click with the left mouse button on a path control point.
• Drag the mouse while holding the left mouse button down.
• Release the mouse button.

To insert a path control points:
• Select a single path with the left mouse button.
• Click on the tool corresponding to the type of control point to insert (line, arc, spline...).
• Use the left mouse button to click on a path control point (the cursor appear as a cross).
• Drag the mouse to the desired position.
• Release the mouse button.

To delete path control points:
• Select a single path/object with the left mouse button.
• Use the left mouse button to click on a path control point (the cursor appears as a cross).
• Press the Delete key



Arrow tool 

Keyboard shortcuts: 'e', 'E', '9', Return key to activate consecutively Arrow tool and the tool last used.

The arrow allows you to select, move and resize objects and groups.

The arrow is also used to modify the outlines of drawing objects by moving, inserting and deleting path 
control points.

To select objects
To move objects
To enlarge and to reduce objects
To delete objects
To modify the outline of objects

See also:
Moving the drawing inside the drawing window



Common properties of drawing tools

When a drawing object is selected:
1 NeoDraw shows the selection by displaying, at the four corners and on the sides, block control points 

which allow the distortion of the object(s).
2 When a single element is selected path control points also appear. These control path points can be 

moved or deleted (Delete key). New control path points of different types (line, arc, spline...) may 
also be inserted.
See: To delete or to insert a control path point

Path control points color:
The Color Ctrl points option (when checked) in the Preferences dialog allows path control points to be 
displayed in different colors, according to their type:

• Line points in blue,
• Arc points in green,
• Cubic spline points in red,
• Quadratic spline points in red,
• Bezier  points in violet,



Ellipse tool 

Keyboard shortcuts: 'q', 'Q', '4'.

This tool is used to draw ellipses or circles.

To draw an ellipse:
• Click with the left mouse button.
• Drag the mouse.
• Release the mouse button.

To draw a circle:
• Proceed as for an ellipse while holding the Ctrl key down.

To modify, delete or move ellipses, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Rectangle tool 

Keyboard shortcuts: 's', 'S', '5'.

This tool is used to draw rectangles and squares.

To draw a rectangle:
• Click with the left mouse button.
• Drag the mouse.
• Release the mouse button.

To draw a square:
• Proceed as for a rectangle while holding the Ctrl key down.

To modify, delete or move rectangles see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Rounded rectangle tool 

Keyboard shortcuts: 'd', 'D', '6'.

Use this tool to draw rectangles having rounded corners.

To draw a rounded corner rectangle:
• Click using the left mouse button.
• Drag the mouse.
• Release the mouse button.

To draw a rounded corner square:
• Proceed as for a rounded rectangle while holding the Ctrl key down.

To modify, delete or move rounded rectangles, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Arc tool 

Keyboard shortcuts: 'w', 'W', '1'.

Use this tool to draw elliptical arcs.

To draw an elliptical arc:
• Click using the left mouse button.
• Drag the mouse.
• Release the mouse button.

Note: to draw a reverse arc, proceed as is explained above while holding the Ctrl key down.

To modify, delete or move elliptical arc, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Line tool 

Keyboard shortcuts: 'x', 'X', '2'.

This tool is used to draw lines and broken lines.

To draw a line:
• Clcik with the left mouse button.
• Drag the mouse.
• Release the mouse button.

To draw an horizontal or a vertical line, or a line with a rotation step of 15°:
• Click using the left mouse button.
• Proceed as for a normal line while holding the Ctrl key down.

To draw a broken (segmented) line:
• Draw a line as explained above.
• Insert a point at the last line point.

To modify, delete or move lines see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Cubic spline tool 

Keyboard shortcuts: 'c', 'C', '3'.

Use this tool to draw cubic spline.

To draw a cubic spline:
• Click using the left mouse button.
• Drag the mouse.
• Release the mouse button.
• Insert new spline points from the last point.

Note: when the mouse cursor is situated near a spline control point, it will appear as a small arrow 
indicating the direction of the segment joining the preceding and next spline control point.

To modify, delete or move cubic splines, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Stars 

Keyboard shortcuts: '0', zero.

This tool is used for drawing stars, polygon, rays, etc.
Click on this tool using the right mouse button to open the Star Manager dialog box.

To draw a Star:
• Click on the drawing using the left mouse button.
• Drag the mouse.
• Release the mouse button.

Setting options in the Star Manager dialog:
• Options (Star, Polygon, Ray, NeoDraw):specify the type of object to draw. By default the object is a 

star (with 8 branches). QSpline: this option creates Spline control points at the object angles.
• Number of branches: specify the number of branches (for Star or Ray), or the number of sides (for 

Polygon or NeoDraw objects).
• Internal circle: specify the size of the internal circle (for stars only) as a percentage of the star's size.
• Start angle: specify the rotation of the object to create. The buttons 0°, 30°, 45°... automatically set 

those standard values.



Quadratic spline tool 

This tool is used to draw quadratic spline-based curves.

To draw a quadratic spline:
• Click on the drawing using the left mouse button.
• Drag the mouse.
• Release the mouse button.
• Insert new spline points from the last point .

Note: when the mouse cursor is situated near a spline control point, it will appear as a small arrow 
indicating the direction of the segment joining the preceding and next spline control point.

To modify, delete or move cubic splines, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Bezier tool 

Allows the drawing of bezier curves.

To draw a bezier curve:
• Click on the drawing using the left mouse button.
• Drag the mouse.
• Release the mouse button.
• Insert new Bezier points from the last point drawn.

Note: When the mouse cursor is situated near a Bezier control point, it will appear as a small arrow 
indicating the direction of the segment joining the preceding and next Bezier control point.

To modify, delete or move curves, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Rotation tool 

Use this tool to rotate a single drawing object or a group.
• Select an object or a group of objects.
• Click on the Rotation tool.
• Use the left mouse button while dragging the mouse to rotate.
• Release the mouse button.

To modify or cancel a rotation:
• Select an object or a group previously rotated.
• Click on the Rotation tool.
• The center of the rotation appears as a small cross. Use the left mouse button to click on the center 

and drag it to a new location.
• To remove a rotation, activate the Delete key when the mouse cursor is located at the center of the 

rotated object (the cursor will appear as a large cross).

Note 1: by holding the Ctrl key down when changing an object's rotation, the object will be duplicated.

Note 2: by holding the Shift key down during rotation, the rotation snaps to 15° increments.
The Shift and Ctrl keys may be used simultaneously.

Other distortions:
 Warp distortion
 Resizing
 Symmetry
 Skew tool
 Lens projections



Lens projections tool 

The Lens dialog box allows you to choose either a Spherical or Black hole projection. These options are 
accessed by clicking on the tool using the right mouse button.

Projections can be applied to one or several drawing objects and to groups.

To apply a projection:
• Select one or several objects (or groups).
• Click on the Lens tool using the left mouse button (to change the type of projection, use the right 

button).
• Click and hold down the left mouse button at the center of the area to which the projection is to be 

applied.
• Drag the mouse.
• Release the mouse button.

To modify or remove a projection:
• Select an object or a group previously distorted.
• Click on the Projection tool.
• Use the left mouse button to click on the center of the projection and drag the mouse to move the 

center of projection. Click with the left mouse button at the circumference of the projection and drag 
the mouse to modify the radius of the projection.

• To remove a projection, press the Delete key when the mouse cursor is located at the center or on the 
circumference of the projection.

Other distortions:
 Warp distortion
 Resizing
 Symmetry
 Rotation
 Skew tool



Skew tool 

Use this tool to skew selected objects and groups.
• Select a drawing object or a group.
• Click on the Skew tool..
• At the center of the selected object, click and hold down the left mouse button.
• Drag the mouse.
• Release the mouse button.

Other distortions:
 Warp distortion
 Resizing
 Symmetry
 Rotation
 Lens projections



Comet tool 

This tool allows you to create a sprayed effect, the pattern consisting of various forms (circles, triangles, 
lozenges, squares) along freehand strokes.

• Click on the Comet tool using the left mouse button.
• Create a stroke by dragging the mouse across your drawing while holding down the left mouse button.
• Release the mouse button.

To modify the options of a selected Comet object, access the Comet dialog:
• by clicking on the Comet tool with the right mouse buton,
• or by selecting the Comet command from the popup Attributes menu.

Comet tool options:
When drawing a stroke with the comet tool, you will see a line of small points on screen. The sprayed    
objects are generated around these points.
The slower the mouse moves, the more points are generated and the denser the result.
The sprayed form depends on several parameters::
- the Number of elements around each point.
- The Comet radius which defines size of the area around each point which contains the scattered 
elements (circles, triangles, lozenges, squares).
- The Points radius (in tenths of mm) defines the size of the individual elements (circles, triangles, 
lozenges, squares).
Each of these parameters can be increased or decreased, from the beginning to the end of the stroke.
The elements (circles, triangles, lozenges, squares) may also be randomly rotated using Free angle.



Scissors tool 

This tool is used to cut a drawing object into individual paths/objects.

Method:
• Select a drawn object (you may select using the Scissors tool)
• click on a path contro point of the selected object.

Notes: the Join 2 lines command of the popup Attributes menu allows joining two paths.



Stamp tool 

This tool allows you to place symbols and clipart into your drawing.

Clicking on the Stamp tool opens the Stamp Pad window, which can contain all kinds of NeoDraw 
objects. These objects are stored in a file named MULTI.TEO.

Using the Stamp tool:
• Click on the Stamp tool. This will open the Stamp Pad window, displaying the active Stamp object.
• Choose an object by using the scroll bar.
• Click on the desired position in your drawing to place the stamp.

or
• Click on your drawing using the left mouse button, drag the mouse and release the mouse button to 

place the stamp at a larger or smaller size.

Add button is used to add a selected object to the list of stamps.
To add several elements as a single Stamp, it is first necessary to group them.

Delete button removes the visible object from the Stamp window.



Origin 

Located at the intersection of Horizontal and vertical rulers, the Origin tool allows you to change the 
location of the drawing's origination point.

Method:
• Click on the Origin tool using the left mouse button,
• Drag the mouse,
• Release the mouse button.

Rulers will then display the new origin coordinates.

To restore the origin to its original location, click with the right mouse button on the Origin tool.
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Menus 

File
Edit
Modify
Options
Attributes
Zoom
Windows
Help

Popup Attributes menu



File menu

The File menu contains commands allowing you to start a new drawing, to open and to save existing 
drawings, to import/export, to print, to setup the printer, and to leave NeoDraw.

New

Open...

Save

Save as...

Clipart...

Template...

Import

Script...

Plotter... HPGL

Image... PCX

Image... BMP

Image... TGA

Metafile... WMF

Export

Metafile... WMF

Plotter... HPGL

Image... BMP

Postscript...PS

Print...

Contrel panel...

Exit

1, 2, 3 .. File name



Edit menu

The Edit menu contains commands to cancel actions, delete, copy    and paste objects or styles and to 
select all objects in your drawing.

Undo

Redo

Delete

Cut

Copy

Paste

Paste Special

Duplicate

Copy style

Paste style

Select all



Modify menu

The Modify menu contains commands allowing you to modify the elements in your drawing.

Group

Tile Object

Ungroup

         Edit  

Information...

Arrange

Align

Symmetry

Assemble

Disassemble

Warp...

Blend shapes...

         Join on a path...  

         Split text  

         Mask  



Options menu

The Optionsmenu contains commands that allow to configure rulers, grid and drawing size, to specify 
default preferences, to display color palette and rulers, to snap to or hide guidelines, and to access 
external programs directly.

Grid...

Page configuration...

Preferences...

Palette color

Rulers

Toolbars...

Guidelines

Quick display

Display bitmap

External programs



Attributes menu

The Attributesmenu contains commands to modify attributes for text, drawing and automatic dimensional 
measurements, to modify and to create new colors, to create color gradient fills, to access special 
characters from the Keyboard utility, to manage layers, and to modify line styles.

Text...

Drawing...

Dimension...

Color...

Gradient...

Keyboard...

Layers...

Line

popup Attributes menu:
The Attributes menu may easily be called by using the right mouse button to click inside an active 
drawing window.



popup Attributes Menu 

Call by using the right mouse button to click inside an active drawing window.

In addition to the normal Attributes menu commands, this popup menu also has (depending on 
circumstances) the following commands:

• Group Groups objects into a single object when more than one object is 
selected.

• Ungroup Ungroups into separate objects when a group is selected.
• Edit Edit a text element or a tiled object (if one is selected).
• Font Displays a popup menu for changing the NeoDraw text font being 

used. When the text in a dimension measurement is selected, you 
may modify the font used on the measurement line using the 
standard Windows Fonts dialog.

• Close: Does the same thing as the Closed check box of Drawing 
attributes dialog. Produces a solid filled interior for the selected 
drawing element or path(s).

• Open Empties the interior of the selected element/path(s).
• Join 2 lines Joins two differents drawing elements, creating a line between the 

last point of the first element and the first point of the second 
element.

• Assemble Assembles selected objects, uniting them into a single object.
• Disassemble Disassembles a selected object (previously assembled), breaking it 

into its former parts.
• Edit Tiled object Opens the Tile Object dialog. 
• Blend shapes... Appears only when 2 drawing elements (vector shapes) are selected 

which have the same number and types of control points. This 
comand opens the Blend Shapes dialog.

• Split text Converts NeoDraw text into editable drawing objects. Use this to 
modify the shapes of individual letters.
Note: a copy of the original text is retained, on top of the new 
elements.

• Edit Bitmap Displays a submenu containing names of paint programs which 
Windows lists as being available. Select any of these programs to 
edit the selected bitmap.

• Join on a path... Opens the Join with a path dialog.
• Comet Opens Comet dialog, when shape sprayed with the comet tool is 

selected.
• Scale... Opens Dimension scale dialog box when a dimension 

measurement line is selected.
• Remove dimension Removes the measurement dimension of a selected line or object.
• Undo horizontal symmetry removes horizontal symmetry applied to NeoDraw text or a group.
• Undo vertical symmetry Removes vertical symmetry applied to NeoDraw text or a group.
• Delete transformations Removes all transformations aspplied to NeoDraw text or a group. 
• Edit drive surface Opens    Bézier Surface dialog box.



Zoom Menu

The Zoom menu contains commands that allow you to increase or decrease the magnification for the 
drawing displayed in the active drawing window.

 Fit on screen (F9): displays either the most important part of the drawing, (if possible, the entire page) 
or zooms to 100% magnification.

 On selection (key /): zooms in on the currently selected elements.

100 % .. 800%: zooms at these rates.

Full screen (F8): displays the visible part of the active drawing using the entire screen area (without 
menu, etc.).



Windows menu

The Windows menu contains commands that allow you to organize the drawing windows present on the 
screen.

Cascade      Shift + F5  command: Presents open drawings as an overlapping stack of windows. This 
is the default method.

Tile      Shift + F4  command: reorganizes the display of drawing windows across the screen in such a 
fashion that they do not overlap.

Arrange icons command reorganizes the icons for your drawings by aligning them across the bottom of 
the main window.

Close all : Closes all drawing windows present on the screen.



Help menu

Index command: Opens NeoDraw's Help system and displays its contents page.

Topic search command: displays the Help cursor. Use the Help cursor to select a menu option or a tool, 
and more information about that feature will be displayed. Activate twice to cancel the command.

Using Help command: command: displays the Windows Help module, winhelp.hlp, giving information on 
the use of the help system.

Info bubbles command: If the checkmark ( ) is visible, the Info bubbles describing individual tools and 
icons are displayed when the mouse moves over toolbars.
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New command File menu         

Opens a new, blank drawing.

Keyboard shortcuts: Ctrl + N.

The new document has the name "Noname" until you save it under another name using the (Save as 
command under the File menu).



Open... command File menu        

Opens a dialog box (file selector) which allows you to load a NeoDraw drawing which has been saved 
previously to your disk.

Keyboard shortcuts: Ctrl + O.

Enter or select the name, directory and disk for the file you wish to load.

Enter the extension '.TBK' if you want to restore the previous version which was overwritten when the 
drawing was last saved.

Note: NeoDraw makes a backup copy of a file if the option Make Backup is checked in the 
Preferences dialog. Backup files have a '.TBK ' extension.



Save command File menu        

Opens a dialog box for saving the currently active drawing to your disk.

Keyboard shortcuts: Ctrl + S.

If you use an existing file name, NeoDraw asks if you wish to overwrite the existing file.

The File Save command saves the file in the active editing window to your disk.

If the file has yet to be assigned a filename (Unnamed.TEO), NeoDraw opens the Save As... dialog so 
you can rename the file and save it in a different directory or drive.

Note: NeoDraw makes a backup copy of files when the option Make Backup is checked in the 
Preferences dialog. Backup files have a '.TBK' extension.



Save as... command File menu        

Saves the active document to disk.

Enter or select the name, directory and disk of the file that you want to save.

Note: NeoDraw makes a backup copy of the file if the option Make Backup is checked in the 
Preferences dialog. Backup files have a '.TBK' extension.



Clipart... command File menu        

Opens the Clip-Art dialog window.
The Clip-Art dialog window allows selection of predefined objects from the clipart library for placement 
into your drawing.

Keyboard shortcuts: Ctrl + K.

Use of the Clip-Art dialog:
• List at left contains all the words linked to clipart.
• Click on a word to display associated words, topics, themes, subjects, etc. in the column at the right 

side.
• Click on the See button (or to double-click a word from the left list) to display a preview of the 

document containing the associated clipart.
• Double-click on the preview to paste the object into your drawing.
• Click on the Open button to open the file containing the associated clipart.



Template... command File menu        

Opens the Template dialog box.

Keyboard shortcuts: Ctrl + T.

This dialog box allows you to use an existing NeoDraw file as a template, to load and to view these files.

The selected file is shown on the right. NeoDraw searches first for a bitmap file or a WMF file and, if none 
exists, the NeoDraw file (with ".TEO" extension).

The Choose a template list contains names of NeoDraw files that may be used as templates.

The Open template button opens the selected file.

The New document button closes the Template dialog box and creates a new drawing.

The Open file... button closes the Template dialog and loads the File open dialog box to select a file.

The Add... button loads the File open dialog box to add a new template to the list of templates.

The Del... button removes the selected file from the list of templates.

The Close button closes the Template dialog box.



Import Script TXT command File menu

Opens    the File open dialog box, where you may specify the name of an ASCII text file with a '.TXT' 
extension to load into your drawing.

This command enables NeoDraw to read an Ascii file containing a description of vector arrays. NeoDraw 
places the objects corresponding to that description into the current window.

- See the 2 examples : ETOILE.TXT and SINUS.TXT, which were generated by the programs 
ETOILE.PAS and SINUS.PAS that are also included on your NeoDraw disk.

- Pascal or any other language can be used to generate such script files.
- Use < > or    <,> or <;> to separate data.



Import Plotter HPGL command File menu         

Opens    the File open dialog box, used to specify the name of an HPGL plotter file having a '.PLT' 
extension to load.

 NeoDraw then opens the HPGL Import dialog, allowing you to select several options:
• Close shapes: polygons are closed (and    therefore filled with the selected color).
• Invert X & Y axis: axes are inverted in X and Y.
• Line thickness by color: NeoDraw interprets thickness of the outline according to the color of the 

outline.

Notes:
1 - In HPGL files, NeoDraw reads:    thickness of line, texts, colors, HPGL coordinates.
2 - You may drag and drop an HPGL file from the Windows File manager



Import Image... PCX command File menu        

Opens    the File open dialog box where you may specify the name of a Bitmap file with '.PCX' extension 
to load into your drawing.

Note: For PCX images, NeoDraw imports monochrome, 256 color (type 5) and 16.7 million color (type 
5) image resolutions.



Import Image... BMP command File menu        

Loads the File open dialog, where you may specify the name of a    Bitmap file with '.BMP' extension to 
load into your drawing.



Import Image...TGA command File menu        

Loads    the File open dialog, where you may specify the name of a Bitmap file with '.TGA' extension to 
load into your drawing.

Note: NeoDraw imports compressed and uncompressed 24-bit TGA bitmaps (types 2 and 10).



Import Metafile... WMF command File menu        

Loads the File open dialog, where you may specify the name of a file with a '.WMF' extension.



Export Metafile... WMF command File menu         

Loads the File Save As dialog, where you specify a filename.

The selected objects in the active window are saved in the Windows Meta File format, using the filename 
you specified.



Export Plotter... HPGL command File menu         

Loads the File Save As dialog, where you specify a filename.

The selected objects of the active windows are saved in HPGL format, using the filename you specified.



Export Image... BMP command File menu        

Opens a dialog box in which you will specify the filename. This will be used to save the selected objects 
using the BMP format.



Export Postscript... PS command File menu        

Opens the Postscript Export dialog box. You may select several options for exporting the active 
document in a Postscript file format:

Options
• 4-color Separation: with this option NeoDraw generates a Postscript file allowing 4-color film 

separations. Using this option allows access to the following two options.
• Negative: used to generate a negative image film output.
• Offset direction: the document is inverted, as if you looked through the printed page transparently.

Colors
• Each option Cyan, Magenta, Yellow and Black, corresponds to a sheet of film. Values indicated 

beside these options correspond to the orientation of the screen ruling. Using a different orientation 
for each film aids in avoiding moire effects.

• Screen ruling: for an office laser printer, use a setting of 60.
• Selection: to export only selected objects.
• All: to export the total drawing.

Note: Invisible planes remain invisible (not exported). With planes in rapid display, only outlines are 
exported.

• On port: send the Postscript file directly to your Postscript printer or other Postscript peripheral 
(connected to this port).    The Port button allows you to select the port.

• On file: option to generate a Postscript file with the '.PS' extension.

Once you have selected and modified the Postscript export options, select the OK button. NeoDraw then 
opens the Save as dialog, where you will be asked to specify a filename.

Notes on Postscript export.
Not exported:
• Windows bitmaps, (except 24-bit DIB, 24-bit TGA and monochome PCX).
• Metafiles.
• Periodic effect in gradient fills.
• Assembled drawings containing too many points (see your Postscript device documentation).



Print... command File menu        

Prints the document in the active drawing window.

Keyboard shortcuts: Ctrl + P.

Opens the Printing dialog, allowing you to setup and print the active document.
The scale of the printed document can be other than 100%. The size of the document can be adjusted to 
the page size. The printout of a document can be spread over several pages with or without adding an 
extra margin for trimming.
You may also change the printer, print several copies of the document, setup the printer, print crop marks 
and registration marks, print only selected objects, print in rapid/draft mode, center the printing on the 
page, print the drawing name, the date, the time and the scale used to print.

Using the Printing dialog box:

Scale
100%: this is the default printing scale and will print the drawing as shown on the page (as set up using 
Options/Page Setup).
Defined: check this option to print the drawing at a scale other than 100%.
Fit on paper: check this option to fit the drawing onto a single page.
Notes: This option is useful when printing a drawing larger than the paper used in your printer.

The size of this drawing must have been setup with the (Page configuration... command under 
the Options menu) to a different format than the paper (e.g., printing a legal-sized drawing on 
letter-sized paper).

Overlap: use this option when tile printing a larger drawing onto several sheets of printout. You may 
specify (Defined option) an extra margin on each sheet to help when trimming and pasting up the 
output.

List of printers
This is a combo box which displays the name of the active printer and a list of available printers.
By selecting a printer from the list or by typing its name in the editing box, this printer becomes active.
By default the active printer is the same as selected in the Windows Printer setup dialog.

Copies
Indicate here the desired number of printouts.
By default NeoDraw prints one copy of the drawing.

Printer configuration button
Opens the Windows Printer setup dialog box.
This dialog allows you to configure the active printer.

Options
Crop marks: prints horizontal and vertical marks at the corners of the document. These marks will act 
as guidelines when trimming the drawing after printing.
Registration marks: prints marks at the outside and mid-distance of horizontal and vertical extremities 
(e.g.: for transparent or offset films). This option is available when Crop marksoption is selected.
Selection: prints only the selected elements of the active drawing window. This option is checked by 
default if elements are selected when you choose the Print command.
Fast: prints a draft copy. Only the outlines of drawings are printed, without fills, with hatched rectangles 
instead of of bitmaps, and gray rectangles instead of Windows text. Fast draft printing is identical to the 
display when using the command Quick Display of the Options menu.
Center on paper: centers the drawing on the printed page.
Name+Date: prints the name of the file, the date and the computer system's time at printing, plus the 
scale of printing if it is other than 100%.



Activate the Ok button to begin printing.

A button will appear which allows you to halt the printing process by activating the Esc key or the Cancel 
button.

See: Control panel...



Control panel... command File menu        

Opens Windows Control panel.

Use this function to change the default printer. To modify printer setup, activate the Printers icon.

Important:
- changing the paper size modifies the size of the drawing in NeoDraw when the page size Printing 

area option is checked in the Page configuration dialog box.

Note: NeoDraw can display a drawing with a maximum size of 20" x 20" (51cm x 51cm)



Exit command of File menu 

Quit program.

Closes all drawing windows and asks to save files which have been modified.



1, 2, 3 .. File name command of File menu

Loads a previously open or saved drawing file for editing.

The command 1...    File name loads the file last opened; the command 2...    File name loads the 
second-to-last opened file, etc.

The number of drawing files shown on the menu in the configuration file.
NeoDraw.ini.
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Undo command Edit menu        

Cancels the last modification to the active document.

Keyboard shortcut: Alt + BkSp (Backspace)

Undo allows you to cancel up to 9 actions on the layer on which you are working. When you change the 
active layer you can no longer cancel actions in the preceding layer.
The number of Undo levels may be changed (1 to 9) in the Preferences dialog box.

NeoDraw indicates what will be Undone, and asks you to confirm the cancellation.

Note: The Redo command of the Edit menu cancels the last Undo command.



Redo command Edit menu        

Restores the action cancelled by the Undo command.

Keyboard shortcut: Shift + Alt + BkSp (Backspace)

Functions similarly to the Undo command.



Delete command    Edit menu        

Erases selected objects.

Keyboard shortcut: Del



Cut command Edit menu        

Removes the selected object(s) and places it onto the clipboard.

If nothing has been selected, this command is not available.

Keyboard shortcut: Shift + Del.

Notes: NeoDraw places 2 versions of selected objects onto the clipboard, one in vector format (e.g.: to 
paste into Write or Winword) and the other a bitmap (e.g.: to paste into Windows versions of 
QuikMenu, NeoPaint or NeoBook).
- the Preferences dialog box allows either of these two formats, or both, to be placed on the 
clipboard.

- the Clipboard  contains two commands Mode point and Image, for bitmap and vector 
formats (respectively).



Copy command Edit menu

Makes a copy of the selected objects onto the clipboard.

Keyboard shortcut: Ctrl + Ins.

If nothing has been selected, this command is not available.

See notes of the Cut command of Edit menu.



Paste command Edit menu        

Inserts a copy of the clipboard's content onto your drawing.

Keyboard shortcut: Shift + Ins.

YoYou can paste bitmap and vector objects (metafile) which were last placed onto the Clipboard with the 
Copy command of the Edit menu - either from NeoDraw or from another Windows program.

See:

• the Clipboard  contains two commands Mode point and Image, for bitmap and vector formats 
(respectively).

• the Preferences dialog box.



Paste special command    Edit menu        

Opens the Paste special dialog, allowing you to choose among the formats contained in the clipboard.

Keyboard shortcut: Shift + Ctrl +  Ins.

See:
Paste and Copy commands of Edit. Menu.



Duplicate command Edit menu        

Duplicates selected object(s) and displays this copy beside original object(s) (1cm to right, 1 cm down).

Keyboard shortcut: Ctrl + X.



Copy style command Edit menu        

Copies the style of a selected object.

To use the style for another object, select that object and activate the Paste style command from the Edit 
menu.



Paste style command Edit menu        

Uses the style (line and fill characteristics) last copied for the currently selected object(s).



Select all command    Edit menu        

Selects all the contents of the active drawing window.

Keyboard shortcut: Ctrl + A.



Group command Modify menu        

Groups all selected objects into a single element.

Keyboard shortcut: Ctrl + G.

It is useful to group elements:
• to stretch, skew or Warp several objects together,
• to move other elements between them.
• to easily select an element without risk of deforming it.

Note: the Group command places the group, including elements that compose it, in the foreground.
A group can be moved behind or in front of other objects with the    Arrange command.

If nothing has been selected, or if an single element has been selected, the command is not available.

It is possible to group several groups into one: select several groups and execute the Group command.

To separate grouped elements, execute the Ungroup command.

To group identical elements, use the Tile Object command. Tile Object uses a single element which is 
copied to other locations, producing files which are more compact on disc, more rapidly loaded and which 
occupy less memory.



Tile Object command Modify menu        

Makes a tiled pattern inside a defined area from the selected object.

Keyboard shortcuts: Ctrl + V.

It is possible to tile all kinds of objects: bitmapped objects, text, etc.

Method:
• Select the object.
• Use the Tile Object command.
• Enlarge the element by dragging its block control points while holding down the Shift key. The 

enlarged block is then tiled with however many elements that it can contain.

A Tile Object dialog allows you to specify how the object will be tiled. This dialog box is under the Edit 
command of the Modify menu, or from the Edit Tile Object command of the popup Attributes menu 
when a Tiled Object is selected.

Note 1: to resize or reproportion a tiled area, and to thus modify the size and proportions of the basic 
element, drag a block control point (without using the Shift key).

Note 2: NeoDraw's Tile Object command uses and saves only a single element: so files are more 
compact on disc, load more rapidly and occupy less memory.

Note 3: using the Ungroup command on a tiled area undoes the tiling and restores the basic element.



Ungroup command    Modify menu        

Restores the individual component elements (or subgroups) of an object which has been grouped.

Keyboard shortcut:    Ctrl + U.

Applied on a tiled area, the Ungroup command cancels the tiling and restores the basic element.

If no group has been selected or if several groups have been selected, the command is not available.



Edit command Modify menu        

Keyboard shortcut: Ctrl + E

Open:
*-a line editor if the selected object consists of NeoDraw text.
*-a text editor if the selected object consists of Windows text.

*-the Tile Object dialog box if selected object is a tiled area.



Information... command Modify menu        

Displays the Info window giving information on a selected object.

Keyboard shortcuts: Ctrl + I.

X: and Y: indicate coordinates of top and left edges of the selected object
X': and Y':    indicate coordinates of bottom/right edges of the selected object.
L:    and H:    indicate the width and height of the selected object.
MM, CM, Inch and 1440e display X, Y, X ', Y', L and H values, in millimeters, centimeters, inches and 
1/1440 inch (respectively).
Colors: indicates outline, filling and gradient colors with their RGB (red/green/blue) values.

Also indicated, depending on what is selected:
• for a vector drawing:

- the open state (outline only) or closed (object colored), (See drawing attributes.
- the control path point number .

• for a NeoDraw text:
- First 5 characters of the text,
- the font, size (in points) and width of the text.
• for a bitmap:
- the size (width X height)
- the number of bits per pixel. 1 bit = bitmap 16 colors, 8 bits = bitmap 256 colors, 24 bits = bitmap 16,7 

M colors.



Arrange command Modify menu         

 

 

Moves selected object(s) and/or group(s) above, below, to the foreground or to the background.

Background: moves the selected object(s) behind all other objects.
Keyboard shortcut: Ctrl + Shift + R

Above: moves the selected object(s) up one level toward the top of the drawing. If several 
elements have been selected, places the selection on top of the element ahead of the topmost object 
selected.
Keyboard shortcut: Ctrl + Shift + D.

Below: moves the selected object(s) down one level toward the bottom of the drawing. If several 
elements have been selected, places the selection behind the element below the lowest element 
selected.
Keyboard shortcut: Ctrl + Shift + E

Foreground: moves the selected object(s) on top of all other objects.
Keyboard shortcut: Ctrl + Shift + P

Note: the Groupcommand places the group, and the elements that compose it, in the foreground. In 
cases where many elements have to be judiciously arranged, use Layers control to place 
elements on separate drawing layers.



Align command Modify menu         

 

 

 

 

Align selected object(s).

Top: places the tops of the selected objects along the highest part of the selected area.

Bottom: places the base of selected objects at the lowest part of the selected area.

Right: places the right edge of selected objects at the right side of the selected area.

Left: places the left edge of selected objects at the left side of the selected area.

Center Horizontal: aligns selected object(s) according to their respective horizontal centers.

Center Vertical: aligns selected objects along a central, vertical axis.



Symmetry command Modify menu         

Horizontal: flips selected objects along a horizontal axis.

Vertical: flips selected objects along a vertical axis.

The Symmetry function may also be applied to bitmap elements.

To undo a flip, use Symmetry again, except for a    NeoDraw text element or a group: in these 2 cases, 
use the command Undo horizontal
symmetry or Undo vertical symmetry from the Attributes popup menu.



Assemble command Modify menu        

Assembles selected objects into a single object.

For example, the character A is an assembled form, originally constituted of an object forming the 
external outline and another which forms the small internal triangle in the interior of the A.

Keyboard shortcut: Ctrl + Shift + A

Method:
• Apply a color to each elements (to close them).
• Select elements (select more than one element by holding the Shift key down or by dragging the 

selector over the desired objects).
• Activate the Assemble command.

Note:  The assembled element may be modified as for other NeoDraw's objects: i.e., using its control 
points.



Disasemble command Modify menu        

Used to break apart an element which was previously assembled from separate elements.

Method:
• Select object to disassemble.
• Use the Disassemble command.

Note: The resulting elements retain the properties they had prior to being assembled.



Warp... command    Modify menu        

Distorts one, or several, objects or groups.

Opens the Warp dialog.

Using the Warp dialog box:

A sample window shows a sinusoidal projection applied on a rectangle with the same proportions as the 
selected object(s). You may alter the deformation using the following options:

1 - the frequency of the sinusoid, set by moving the horizontal scroll bar:    it can vary from Pi / 2 to 10 
Pi by of Pi / 2.

2 - the amplitude of the sinusoid, set by moving the vertical scroll bar.
3 - the symmetry of the distortion, set by using the Sym check box.



Blend shapes... command    Modify menu        

Opens the Blend Shapes dialog, which allows you to morph between two individual objects produced 
with NeoDraw's drawing tools.

Method:
• Create two elements. The two elements must have the same number of control points and must 

have been drawn with the same tool. Elements may be composed of different types of points (arc, 
line, spline), but the same number of points in the same order.
The simplest way is to duplicate an element and to edit the copy to change its shape.

• Select the two elements.
• Use Blend shapes...
• Indicate in the Blend Shapes dialog, the number of steps used to blend from one element to the 

other (between 3 and 300).
• Click on the Ok button.

Notes: 1 - The transformation uses the shape, filling color and outline colors in producing the blend.
2 - The objects generated with the Blend shapes feature are grouped.



Join on a path... command Modify menu

Opens the Place Object on a Path dialog box.

This allows you to align a group of objects along a path (a shape produced with a NeoDraw tool: line, 
spline curve, etc.).

First create the objects you wish to align along a path.
For example:
• create a shape (with a NeoDraw tool) and then duplicate it. Next, use the Blend shapes feature to 

obtain a group of objects.
• or create NeoDraw text then split it and group the resulting characters.
• or draw any quantity of different objects.

Then draw a path for the objects to follow using one of NeoDraw's drawing tools (such as: line, arc, bezier 
curve, etc.).
Select both the grouped objects and the path and then activate the command Place Objects on a Path 
which opens the Place Objects on a Path dialog. The Place Objects on a Path command will then also 
be available on the popup Attributes menu.

Using the Place Objects on a Path dialog box:
Options:
• Rotation: rotates each object in the group according to the direction of the path.
• Offset: keeps the distance between the objects.
• Start: align the objects from the begining of the path.
• Center: align the objects on the center of the path (if the path is longer than the objects).
• End: align the objects at the end of the path.
Base: specify which part of the objects are aligned along the path (default is the center).



Split text command Modify menu

Converts NeoDraw text into drawing paths.

Notes:
• the Split text command is on the popup Attributes menu when a NeoDraw text object is selected.
• a copy of original text is retained and placed on top of the new elements.
• split text may be placed on a path:

• - group the letters,
• - create a path,
• - select both the group of letters and the path and then use the Place Objects on a Path command.
• - select on the Join with a path dialog, select the left and bottom radio button for the Base attribute.



Mask command Modify menu

Mask a bitmap to place it inside a drawing object or as a fill inside NeoDraw text. The bitmap is will then 
only be shown within the object or NeoDraw text.

Method:
• Select a drawing object (created with a NeoDraw tool: line, arc, spline, ellipse, rectangle) or NeoDraw 

text, and the bitmap image.
• Use the Mask command.
The bitmap will then appear only inside the drawing object.
Notes:

• The drawing object must be closed, check the Closed option, if necessary (Drawing... dialog box or 
Closed command of popup Attributes menu).

It is possible to mask other objects (drawing elements, bitmaps, group, NeoDraw text, tiling...) inside a 
drawing object or a NeoDraw text object using the Mask option of the Drawing dialog.

The Mask attribute can be given to:
• a drawing path (created with the NeoDraw tools: line, arc, spline, ellipse, rectangle),
• a NeoDraw text object.

Method:
• Select a drawing object or NeoDraw text.
• Set the Mask attribute by checking the Mask option of the Drawing dialog (Drawing... command 

Attributes menu).
• The element must be closed, check the Closed option if necessary (Drawing... dialog or Closed 

command of popup Attributes menu.
• Group (Ctrl+G) this element with another (or several other elements: drawing elements, bitmap, 

group, NeoDraw text, paving...).
The other elements appear only inside the element that has the Mask attribute.
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Close command popup Attributes menu 

Closes a selected element and applies the active color (last color selected from the color palette) to it.

Note: this does the same thing as activating the 'Closed' checkbox of the Drawing attributes Drawing 
attributes dialog.



Open command popup Attributes menu 

Opens up a selected element and removes it its color fill.

Note: this does the same thing as the 'Closed' checkbox (inactive) in the Drawing attributes dialog.



Font command popup Attributes menu 

Displays a submenu indicating the name of all available NeoDraw fonts.
Click on a font name to use this font with the selected NeoDraw text object.

To modify the font of a Windows textobject:
• select a Windows text object (including paragraph text),
• use the Edit command of Modify menu.



Line command popup Attributes menu 

Opens a submenu allowing you to apply various line styles to the selected object.



Grid... command Options menu        

Keyboard shortcut: Ctrl + Shift + G

Opens the grid dialog box allowing you to configure, modify, activate or deactivate the grid.

The visual grid
Serves as a visual aid. The grid consists of dots to indicate spacing.
Modification and configuration of the visual grid:

• Activate Visible checkbox to display the grid.
• Enter values (per number of Units) for the spacing in Step X and Step Y.

Magnetic grid
Allows you to precisely size or move objects by forcing object edges to snap to the grid.
Modification and configuration of the magnetic grid:

• Activate Active checkbox to activate the magnetic grid.
• Enter values (per number of Units) for the spacing in Step X and Step Y.

Changing the grid size
Click on the Units: button (the available units are: mm, 1/10 mm, 1/10 inch, 1/32 inch, 1/16 inch, 1/4 
inch) until the desired unit is displayed.

Notes: the units of rulers and coordinates (status line) are set using the Units button in the 
Preferences dialog.



Page configuration... command    Options menu        

Opens the Page configuration dialog, which allows you to modify the size and orientation of the active 
drawing, define the paper color (background) and to configure your printer.

Printing area: sizes the drawing format according to the area of the paper which may be printed on, as 
configured in the Printer section of the Windows Control panel.

The following lists the sizes in mm for the drawing in Portrait orientation (horizontal x vertical):
A5: 148 X 210
A4: 210 X 297
A3: 297 X 420
B5: 182 X 257
B4: 250 X 353
Tabloid: 279,4 X 431,8 (11"x17")
US Letter: 215,9 X 279,4 (8.5"x11")
US Legal: 215,9 X 355,6 (8.5"x14")

Other: indicate in zones 'X:' and 'Y:' the desired horizontal and vertical values respectively (in mm).

Entered values must be between 1 mm and 520 mm.

Portrait and Landscape produce a drawing in vertical or horizontal orientation.

Color: applies a background color corresponding to the color of paper used for printing to the drawing 
surface (this color is not printed, it allows you to visually approximate the final document).

• click with the left mouse button on Paper color to open the popup palette and click again with the left 
button on the desired color,

or
• click with the left button on the desired palette color,
• hold the button down while dragging the mouse to the Paper color zone (the cursor will resemble a 

paint pot),
• release the mouse button.

Printer options...: opens the Printer setup dialog to set configuration options for the current printer.



Preferences... command Options menu        

Opens the Preferences dialog.

Use Preferences to set options for saving, displaying, the clipboard, the
number of undo levels, the definition of line thicknesses and the choice
of units for the display of the rulers, coordinates and grids.

These preferences are saved into the NeoDraw.iniconfiguration file.

Saving
Save Compressed:

Activates or deactivates compression of files saved in NeoDraw.
When compressed, files take longer to load, but use less disk space.

Saving with palette:
If this option is selected, NeoDraw saves the palette with the drawing. The palette will be loaded when 
the drawing is next edited.

Save as WMF:
If this option is selected, NeoDraw saves (when using Save or Save as.. command of File menu) two 
files. One is a NeoDraw format file with '.TEO' extension; the other is a Windows metafile file format 
with '.WMF' extension.

Create Backup File:
If this option is selected, NeoDraw saves (when using Save or Save as.. command of File menu) a 
backup copy of the previously edited version with '.TBK' extension.

Use Win File Selector:
If this option is selected, NeoDraw uses the standard Windows dialog boxes to open and save 
drawings.

Display
Show Status Line:

Activates or deactivates the status line at the bottom of the screen.
If this option is selected, the status line is present.

Color Ctrl Points:
If this option is selected, the control drawing points are displayed with different colors according with 
their type: line points in blue, arc points in green, spline points in red.

Fast Gradient:
If this option is selected, the gradient fills are displayed in rapid mode with a limited number of steps. 
This will speed the display, but be less accurate.
This option does not modify the printing of gradient fills. Gradients will retain the attributes set in the 
Gradient dialog.

Fast move:
If this option is selected, objects do not display outlines but only a rectangle when moving. Objects 
display more rapidly when dragging.
By pressing both right and left mouse buttons while dragging, elements display their outline.
If this option is not selected, the function is inverted: elements dragged using just the left mouse 
button display outlines.

256 Color Palette:
If this option is selected, NeoDraw uses a pure color palette. Use this option if your display is capable 
of 256 colors.

Fixed palette:
Activates or deactivates the fixed palette at the bottom of the screen.
If this option is selected, the fixed palette is present.

Blue Pg Border:
Activates or deactivates display of a blue frame around the page.



If this option is selected, the blue frame is displayed.
Progress Bar:

Activates or deactivates the bars at the bottom of the main NeoDraw window which indicate the 
program is working.

Small Ctrl Pts:
Activates or deactivates display of small points at the corner of each element inside a group.
If this option is selected, the small control points are displayed.

With Rectangle:
Activates or deactivates displaying rectangle(s) (outlining the selection) when dragging an object(s).;
If this option is selected, rectangle(s) are displayed.

Large palette:
Activates or deactivates the big palette window    in place of a smaller one.
If this option is selected, the larger palette is displayed.

Large Tools:
Activates or deactivates a big tool palette window in place of the smaller.
If this option is selected, the larger tool palette is displayed.

Frame Win-Text:
Activates or deactivates display of a frame around Windows text when not selected.
If this option is selected, the frames are displayed.

Clipboard
Copy Bitmap:

If this option is selected, NeoDraw places a bitmap format version of selected objects into the 
clipboard when the Copy or the Cut command in the Edit menu is used.

Copy Image (metafile):
If this option is selected, NeoDraw places a metafile format version of selected objects into the 
clipboard when the Copy or the Cut command of the Edit menu is used.

Undo Levels
From 0 to 9 undo levels are available. You can undo up to 9 actions.

Line...  
 

 

Opens the Line thickness dialog, allowing you to preset the 4 line thicknesses (in tenths of millimeter) 
used on the Toolbars buttons.

 
 

 
.

Units...
Opens the Units dialog, allowing you to choose a unit (millimeter or inch) for displaying rulers, 
coordinates, and the area shown on the status line.



Palette color command Options menu        

Displays or removes the floating palette.

If the checkmark ( ) is visible, the floating palette is displayed.



Rulers command Options menu        

Displays or removes the rulers.

If the checkmark ( ) is visible, the rulers are displayed.



Toolbars... command Options menu        

Opens the Toolbars configuration dialog box.

Toolbars are composed of icon buttons.
An icon is quicker to use than the selecting the same command from the drop-down menu.

The Toolbars configuration dialog box allows to activate, configure and position the 4 toolbars.

Any icon can be placed onto one of the 4 toolbars.

Using the Toolbars configuration dialog:

The upper list represents available icons, those that are not present in any toolbars.

The lower list represents icons allocated to the selected toolbar(1, 2, 3 or 4).

Each line of these lists represents an icon and the description of the action that is allocated to this icon.

To add or insert an icon into a bar:
• select a toolbar by activating one of the four radio buttons, 1, 2, 3 or 4.
• select an icon from the list above, clicking on a line.
• The Space and Half-Space elements allow you to use spaces to arrange icons into groups.
• activate Add or Insert button.

To remove an icon from a toolbar:
• select a toolbar by activating its radio button: 1, 2 , 3 or 4.
• select an icon on the lower list, clicking on a line.
• activate Remove button. The selected icon is placed back on the upper list of available icons.

To position a toolbar at top, left or right:
• select an iconbar, activating its radio button: 1, 2 , 3 or 4.
• select a position Top, Left or Right.
Note: you may place up to four toolbars on either the left or right side, but only one on top.

To remove all toolbars from screen:
• deactivate the Active checkbox.



Guidelines command Options menu

A guideline is created by pressing the mouse button on a ruler, and dragging the mouse to the desired 
position before releasing the mouse button.

If the magnetic grid is activated, the guideline will snap to the nearest grid point.

See: Using guidelines: To position, drag or remove guides.

The Guidelines command activates a submenu including the following commands:

• Visible: when the checkmark ( ) is visible, guidelines are displayed.

• Active: when the checkmark ( ) is visible, guidelines are active (and attract the mouse).
• Create: automatically creates guidelines around a selected element (or the first element of a 
selection). A horizontal guide and a vertical guide are created for each point (line, spline, arc) of element's 
outline.
• Delete: delete all guidelines after asking confirmation.

Notes: guidelines are saved with the drawing.



Using Guidelines

To place a guideline
• hold the left mouse button down on either the horizontal or vertical ruler to obtain either a horizontal or 

a vertical guideline.
• use the mouse to drag the guideline to the desired position.
• release the mouse button.
Notes:
• If the magnetic grid is activated, guidelines will snap to the nearest grid point.
• by pressing the Ctrl key while dragging, the guideline is moved in 1 mm increments (even if the 

magnetic grid is activated).
• if you press the Shift key while dragging, the guideline is moved free of the magnetic grid (even if the 

magnetic grid is activated).

To move a guideline:
• press the left mouse button on the ruler at the position of a guideline.
• drag the mouse.
• release the mouse button.
Ctrl and Shift keys can be used as is explained above.

To delete a guideline:
• click with the right mouse button on the ruler at the position of a vertical or horizontal guideline.

To delete all guidelines:
• use the Delete command under the Guidelines function in the Options menu.



Quick display command Options menu        

Displays the active drawing in either rapid or normal display mode.

When the checkmark ( ) is visible, all elements are shown in rapid mode.

In rapid mode:
• Drawing elements and NeoDraw text objects display only their outlines.
• Each line of Windows text is displayed as a gray rectangle.
• Bitmap objects display as hatched rectangles.



Display bitmap command Options menu        

Displays bitmaps as hatched rectangles instead of as images, to speed screen redraws.

When the checkmark ( ) is visible, a hatched pattern is displayed in place of bitmap images (on screen 
and also when printing).



External programs commands Options menu

External programs can be executed directly from NeoDraw by modifying the configuration file 
NeoDraw.ini, which is located in your Windows subdirectory.

Example:
[Program]
1=&Viewer..., c:\Neodraw\NSVIEW.EXE
2=&Icons..., c:\windows\NSICON.EXE
3=&NotePad..., c:\windows\Notepad.exe
4=&NeoDraw.Ini..., c:\windows\Notepad.exe c:\windows\NeoDraw.ini

For each of the 4 lines of this example, NeoDraw creates a new command in the Options menu. 



Fin v_menu4



Drawing path
A graphic element created with a NeoDraw tool, e.g.: Ellipse, Rectangle, Rounded rectangle, Arc,, Line, 
Cubic spline, Quadratic spline, Bezier curve.
A drawing path consists of control path points which appear when a the object is selected. Control path 
points of different types (line, arc, spline...) may be inserted into the same object.
Each drawing path has a starting and end point: the start has a control point smaller than other control 
points.



Gradient angle
The angle which indicates the direction of the gradient.



Group
An object consisting of several elements of any kind. A group can contain other groups.



Attributes
Parameters assigned to an element. Color and outline thickness are examples of attributes for drawing 
objects. For text, attributes are the font or the size of characters.



Duplicate
This action produces a copy of an object.



Element
Any object which may be included inside a NeoDraw drawing: drawn object, text object, bitmap object...



Icon
Icon editor (EGA/VGA for DOS programmers in Turbo Pascal. Supports mouse and scrolling menus. A 
unit allows to insert icons inside Turbo Pascal source code.) In France the registration fee is 150 F ($30).



Rulers
Indicate the drawing's    measurements, at the drawing's printed size.
Rulers display may be turned off or on by using the Rulers command of the Options menu.



    Guidelines
These are horizontal or vertical lines, which can be set so that objects snap to these when drawing. They 
allow you to structure drawings and precisely position objects.



Grids
A set of equally distributed horizontal and vertical alignment points. You may define the grid's spacing.
There are two different grids:

• the Visual grid displays a grid on your screen. This grid is not printed.
• the Magnetic grid snaps the mouse to the nearest grid point.
The spacing used for each type of grid can be different than for the other.



Impact
A DOS-based vector drawing program, for VGA display and supporting the mouse and compatible Epson 
printer.



Block control points
Square control points which are located at the four corners and at the sides of a rectangle containing the 
selection.
The block control points allow selected objects to be deformed and resized.



Path control point
These are points located on a drawing path, which are represented by squares which have a smaller size 
than the block control points.
A single drawing path may use different types of path control points (arc, line, spline, Bezier).
The first control control point shown on a drawing path is smaller than the others.



Style
An object's style consists of its various attributes.
For a drawn object, the style contains the thickness of the outline, outline and fill colors, as defined in the 
Drawing... dialog.
In NeoDraw text objects, the style also consists of text attributes, such as the font, the size of 
characters, etc.



NeoDraw Text
This is text created with special NeoDraw fonts. NeoDraw text objects may be deformed and treated like 
other NeoDraw drawing objects.
NeoDraw text consists of a single line, with a maximum of 40 characters, and is created using the Text 
tool.
Text attributes of NeoDraw text may be changed using the NeoDraw text attributes dialog - accessible 
with the Text command of Attributes menu.
Multiline blocks text using Windows fonts (True Type, ATM, etc.) may also be created.



Windows Text
Text and paragraphs created using a Windows font (True Type, ATM, etc.).
Windows text objects are created by using the Text tool and by using the mouse to drag out a rectangle 
to contain the text while holding down the Ctrl key. The text editor will be launched to allow you to edit 
the text.



Letter Spacing
Spacing between characters.



Status line
Displays the following information (from left to right) at the bottom of the main NeoDraw window:

• the coordinates of the mouse cursor, inches or millimeters, with a 1/10 mm precision.
• zoom rate, or rotation angle when the Rotation tool is active.
• number of selected objects.
• the size of the selection, in inches or millimeters.
• the area in    sq. inches or mm² of a single selected drawing element.
• context-sensitive help information, or the order of display for a selected object when the mouse cursor 

is over this area of the status line.
• color component values (Red, Green, Blue,Light, Saturation, Cyan, Magenta, Yellow, Black), on the 

right side of the status line, when the mouse cursor is placed over a palette color.



Bitmap
Bitmaps are created in a paint program, such as NeoPaint or Windows Paintbrush.

Bitmaps may be pasted into a NeoDraw drawing via the Windows Clipboard.

It is possible to modify the color of a b/w monochrome bitmap:
• select monochrome bitmap,
• click on a color from the palette.

Horizontal and vertical symmetry may also be applied to bitmaps..



Fin de v_terms



Dialog boxes

NeoDraw text attributes
Drawing attributes
Dimension
Palette colors
 Gradient
Keyboard
Layers control Window
Clip-Art
Comet
Dimension scale
Bezier surface

Grid
Preferences
Toolbars configuration
Tiling
Blend Shapes
Info Window
Paste Special



Color palette

There are two types of palettes available: a floating palette, which you may place anywhere on the 
screen, and a fixed palette at the bottom of the main NeoDraw window.

These 2 types of palette are composed of 8 distinct sub-palettes (of 16 colors each).

It is possible to create new palettes, to modify them and to save them (Color... command of the Attributes 
menu).

Two ways to apply a color:
Classic method:

• select the element to color,
• click with a mouse button on a color on the palette.

Drag and drop method:
• use the mouse button to click on a color from the palette;
• drag the mouse until you reach the element to color (the cursor resembles a paint pot);
• release the mouse button.

To apply a color:
• inside a drawing path or to NeoDraw text:

.    Classic method with the left button.
or
.    Drag and drop method with the left button.

• to the outline of a drawing path or to the outline of NeoDraw text:
.    Classic method with the right button.
or
.    Drag and drop method with the right button.

• to Windows text:
.    Classic method with the left button.
or
.    Drag and drop method using the left button.

• to the background of Windows text:
.    Classic method with the right button.
or
.    Drag and drop with the right button (cursor will resemble a brush).

Notes:
- The background of a Windows text object can be assigned only a pure color, the number of 

available colors depends on your screen and your graphics adapter.
- The background of a block of Windows text can be transparent: select the block of    Windows text, 

open the Drawing attributes dialog box, then activate the Transparent radio button.
- The option Saving with palette of the Preferences dialog allows you to save the sub-palette with 

the drawing.

To modify the colors of elements in a group:
• Drag and drop method with the left button for the background or the right button for outlines.

To remove or activate the floating palette:
• Click on the Color Palette command in the Options Menu

See also:
Modification of beginning and end colors of a gradient



NeoDraw Text... Attributes menu        

Opens the NeoDraw text attributes dialog.
This dialog box allows you to modify attributes of one (or several) selected NeoDraw text objects.

May also be accessed from the popup Attributes menu.

Using NeoDraw text attributes dialog:

• the size (in point Didot (1 point didot = 0,3759 mm), can have a value of 1 to 999 points.

• the italic can vary from -45 to +45.    A negative value creates a left-slanting italic.

• the width (in percentage), corresponding to an expansion or to a reduction of the width of characters. 
can have a value of 1 % to 1000%.

• the Ltr spacing (as a percentage of the height of characters), corresponds to    the distance separating 
characters, and may have a value of -50% to 100%. A negative spacing places characters before the 
preceding character.

NeoDraw text    has text attributes and also drawing attributes. All these attributes constitute its style. To 
allocate the same attributes to another NeoDraw    text object, copy and paste the style..

See also:
Creating NeoDraw text
Creating Windows text
Text tool
Text editor



Drawing... Attributes menu        

Opens the Drawing attributes dialog.

This dialog box allows you to modify attributes of one (or several) selected drawing elements.

Drawing attributes are:    line thickness, fill and outline color, open (only outline) or closed (element 
filled), drawing and filling modes, transparent or opaque (for Windows text background) and the mask 
attribute.

Drawing attributes of an object constitute its style.    To transfer the same drawing attributes to another 
object copy and paste the style.

Using the Drawing attributes dialog:

• Line thickness: indicates, in tenths of millimeters, the thickness of the selected element's outline and 
can have a value of 0 to 1000.

• Closed: select this option if you want selected element(s) to be closed (filled with color).

• Drawing mode: defines the mode of painting. The manner is determined according to whether 
interiors of objects and their contours are combined to existing colors on the drawing surface.
In the examples below, the drawing mode is assigned to the form number 2 and colors are identical in 
each example.

 Copy: normal mode, by default.

 And: common colors of the background and the object are combined.

 Or: color of the object and the color of the background are combined.

 Xor: colors in the background and in the object but not in either are combined.

• Filling: example



 on the left Alternate fill, on the right Windingfill.

• Background:determines if the bottom of a block of Windows text will be opaque (fill) or transparent 
(objects placed under are visible).
The Mask attribute allows an object to be seen inside another object with which it is grouped. For 
example a bitmap (or drawing elements, or NeoDraw text) can be solely visible inside a drawing 
element or a NeoDraw text element.
• Select a drawing element or NeoDraw text.
• Select the Mask attribute for the element. The element must be closed, check the Closed option if 

necessary.
• Group this element with one or several other elements (drawing elements, bitmap, group, NeoDraw 

text, tiling...).
The other elements appear only inside the element that has the Mask attribute.

• Line and Fill: to modify outline and fill color of selected elements.
• click with the left mouse button on Line or Fill to open a small color palette, then click on the desired 

color.
or
• click with the right mouse button on Line or Fill to open a chromatic wheel (HLS colors), then click 

with left mouse button on the color desired.
or
• press the left mouse button on a desired color from the standard palette,

- drag the mouse until reaching Line or Fill area in the Drawing Attributes dialog (mouse cursor 
appears as a paint pot),

- release mouse button.

Note: Drawing... command is accessible from popup menu Attributes.



Dimension... Attributes menu        

Opens the Dimensions - End Styles dialog.

It is easy to place dimensions, in NeoDraw: draw a line or a broken line, activate the Dimension 
command in the Attributes menu (or the popup Attributes menu ), indicate parameters of the 
dimension measurement (shape of line ends, position of the dimension, font, scale...).

Dimension parameters constitute a style: to use the same dimension measurement parameters to 
another line use copy and paste the style.

Using Dimensions - Line End Styles dialog:

• Select the shape of endings for the Beginning and the End of the line (in the order which the line was 
drawn). The option Withoutinactivates measurement, and therefore suppresses the dimension.

• Inverted: inverts the direction of the Arrow and Feather line endings.
• Closed: closes the outline of the Arrow and Feather line endings.
• Dimension: displays the line measurement figure.
• Multiline: places line endings at the beginning and end of each segment of a broken (segmented) line. 

When this checkbox is not activated only the first and the last points of a broken line have an endings.
• Colored: line endings are filled with the active filling color.
• Wedges: puts wedges at the beginning and end of a dimension.

• Size: indicates the size of line endings in tenths of millimeters.
• Angle:    indicates the angle of the Arrows and Feathers.
• Sup.: indicates the length of the upper part of wedges in tenths of millimeters (for a dimension line 

drawn from the right to left). If the line has been drawn from the left to right Sup. indicates the length of 
the lower wedge portion.

•  Inf.:    indicates the length of the lower part of wedges in tenths of millimeters (for a dimension line 
drawn from the right to left). If the line has been drawn from the left to right Inf. indicates the length of 
the upper wedge part.

• Measurement pos.: indicates the distance between the measurement text of the dimension and the 
dimension's line, in tenths of millimeters. Negative values are allowed. A positive value places the 
dimension above the dimension line if the line has been drawn from the left to right.

• The Scale... button opens the Dimension scale dialog, allowing you to configure the dimension's 
scale and its format (whole numbers and decimals).

• The fonts... button opens the standard Windows Fonts dialog, allowing you to modify the font, size 
and style of the dimension text.

Removing a dimension:
• Use the Remove dimension command in the popup Attributes menu. Remove dimension 

inactivates parameters of the dimension measurement but preserves the line.

Modification of a dimension:
• Select a dimension.
• Activate the command Dimension....of the Attributes menu.



Dimension scale

The Dimension scale dialog allows you to configure the scale, the unit and the format of the 
measurement (number of integers and decimals).

Ratio:
Scale the measurements using the Ration fields. The first number in the Ratio represents the actual page 
size, measured in 1/10 mm, of the Unit used to scale (e.g., 1 inch = 254, a centimeter = 100, etc.). The 
second number in the Ratio is the number of Units represented by the first number (e.g., if one inch on 
the drawing represents 36", then the Ratio would be 254:36). Common scale Ratios in the U.S. would be 
254:48 (1/4"=1'), 254:96 (1/8"=1'), 254:192 (1/16"=1'), 254:384 (1/32"=1'), and 254:65760 (1"=1 mile).

Unit:
Indicate a wording for the display of units on the measurement (e.g., cm, mm, m, km, inches, etc).

Format:
Indicate in the first box, the number of integers. Use the second box to indicate the number of decimals to 
display.



Color... Attributes menu        

Opens the Palette colors dialog.

This dialog box allows you to modify the colors in the palette (both the floating and permanent palette).

The command Preferences under the Options menu allows you to save the palette with the drawing.

Using the Palette colors dialog:

To select a palette:    the vertical scroll bar on the left side of the dialog box allows access to 8 sub-
palettes. By clicking on the Ok button, the new palette replaces the original in the floating palette.

To modify or define a color:
• The six horizontal scroll bars allow you to modify Red, Green and Blue components (RGB color), as 

well as Hue, Light and Saturation (HLS) of a selected color.
• The CMYK editing areas allow modification of Cyan, Magenta, Yellow and Black CMYK color 

component values.
• Clicking the left mouse button on a desired color from the chromatic HLS wheel selects a color. The 

vertical zone at the right of the wheel modifies the light component.
• With the floating palette:

. click with a mouse button on the desired color on the floating palette,

. drag the mouse until reaching the color to modify (the cursor will change to a paint pot),

. release the mouse button.
• Clicking with the right mouse button over one of the 16 colors displays a mini-palette, grouping 8 sub 

palettes. Click with the left button on the desired color (the right button cancels) and close the mini-
palette.

Open: opens a file with '.PAL' extension containing palettes. The new palettes replace the defaults. Click 
on the Cancel button to return to the preceding palettes Palette files created by Paint Shop Pro (® 
JASC) may also be opened. Note that only the first 128 colors are used.

Save: save the palettes into a file with '.PAL' extension.

The standard Windows Color dialog box is accessible by activating Color... command while 
simultaneously pressing the Shift key. This standard Windows Color dialog box allows modification of the 
16 visible colors of the floating palette.



Gradient... Attributes menu        

Opens the  Gradient dialog.

Using the    Gradient dialog:

To apply a gradient (shaded fill) to an object, the shape must be selected and closed (see Drawing... 
dialog box).

Type
Choose the type of gradient: None, Parallel, Circular, Square.
Periodic option is only available for circular and square gradients.

Note: the periodic effect is not exportable in postscript.

Increment
Step: indicates the thickness of gradient bands in tenths of mm. Must have a value between 1 and 
1000.
Angle: indicates the degree of incline for the gradient bands (parallel gradient). Must have a value 
between 0 and 90 degrees.

Center position
Horizontal and Vertical: indicates the position of the center of gradient for a circular or a square 
gradient. E.g., horizontal and vertical values of 0% put the center of gradient at the top/left of a 
rectangle containing the element.

Modification of the beginning and end colors in gradients:
• click with the left mouse button on the Beginning or the End field. This opens a palette from which 

you may select a color with your mouse.
or drag method:
• click on a palette color with the left mouse button.
• drag the mouse until reaching the Beginning or End field (the cursor will resemble a pot of paint);
• release the button.

Modification of beginning and end colors of a gradient without using the Gradient 
dialog:

• select an object containing a gradient,
• click with left mouse button on a palette color to change the first gradient color,
• hold down the Shift key and use the left mouse button to click on a palette color to change the 

gradient's second color.

HLS: (for Hue, Light, Saturation)
Check this box for using an HLS gradient Otherwise gradients are RGB (red, green, blue).

Note:  Gradient options are also accessible from the popup Atributes menu.



Keyboard... Attributes menu        

Opens a Keyboard window which contains special characters.

Using the keyboard with a NeoDraw text:
• Select a NeoDraw text object or create NeoDraw text using the Text tool.
• Open the Keyboard window with Keyboard... command under the Attributes menu or popup 

attributes menu.
• Click on a character to add it to your text at the cursor position. The active font is indicated on the title 

bar of the Keyboard.

Using the keyboard with Windows text:
• Select Windows paragraph text or create Windows text using the Text tool.
• Activate the Keyboard... command under the File menu of Text editor,
• Click on a character to add it to the text at the cursor position



Layers... Attributes menu        

Opens the Layers control window.

The Layers control window allows you to manage up to 16000 planes. On each plane, objects may be 

displayed in Normal , Rapid 

 or Invisible 

. The Invisible and Rapid options allow the faster display of drawings containing many objects 
(bitmaps for example).

Objects situated on layers other than the active layer are not accessible with the mouse.
You can also copy or move objects from one layer to another.

Using the Layers control window:

Active: indicates the name of the active layer.

The list of layers on the left indicates the names of all existing layers.
• Click on a layer to select it.
• Double click on a layer name to make it the active layer.
• Click on a layer name with the right button to change between rapid, invisible or normal display modes.

Active button makes the selected layer active.

Add button allows the creation of a new layer. Supply a name for the layer in the NeoDraw-Layer dialog.

Rename button allows you to change the name of the selected layer. Type a name for the selected layer 
in the NeoDraw-Layer dialog.

Remove button deletes (after confirmation) the selected layer and all elements on that layer. The active 
layer can not be deleted.

Active only option only displays  the active layer.

The small V , I 

 and R 

 buttons change all layers (except the active layer) to normal, invisible or rapid display mode.

Note: active layer can be in rapid  or normal 

 display mode, but cannot be invisible 

.

Close button closes the Layers control window.



Comet dialog box

Allows you to modify the parameters of a selected object created with the Cometvector spray tool.

The Point group options allow you to define a form (circle, triangle, lozenge, square, multiple) used to 
produce the basic elements (spatters) in the comet object. Multiple option allows all forms to be randomly 
combined.

Free angle option randomly rotates the basic elements in the object.

Valid option allows you modify values (Number , Comet radius, Point radius) which can change from the 
beginning to the end of each stroke.

Number: indicates the number of basic elements to generate around each point when drawing.

Comet radius: indicates the width (in tenths of mm) of the area around each point in the stroke which 
contains the spattered elements.

Points radius: indicates the radius (or the size in tenths of mm) of each basic element.



Bezier Surface dialog box

Modifies the display of surfaces generated by the add-on Drive Surface application.
Accessible by the Edit Drive Surface command of the popup Attributes menu.

Lines: display only the lines.

Vertical Lines: display only vertical lines.

Horizontal lignes: display only horizontal lines.

One color: all squares of the surface using one color.

Checked: color all squares of the surface using two colors, as a checkerboard.

 Gradient: color all squares of the surface using gradient colors from 4 initial colors on the 4 extremities 

of the surface.

To modify colors:
• click on a palette color using the left mouse button.
• drag the mouse until reaching a color field (the cursor will resemble a paint pot);
• release the mouse button.



Tiling dialog box

This dialog allows you to modify tiled object attributes:
• Select an element to tile.

• Simultaneously press the Ctrl and E keys (or use the right mouse button to click on the Text tool )
• The Visible check box allows display (when checked) or hiding (for faster display) tiled elements.
• Use X and Y to specify horizontal and vertical spacing between tiled elements.

Note: to create a tiled area, use the Tile Object command of the Modify menu.



Blend Shapes dialog

This dialog allows you to indicate the number of intermediate elements to generate between two selected 
objects (these elements must have the same number of control drawing points).

This dialog box is accessible from the Blend forms command of the popup Attributes menu.

To blend two shapes:
• Draw an element with a tool - line, spline, arc, ellipse, square...
• Draw a second element having the same number of control drawing points (or duplicate the first object 

and modify its proportions).
Note: one of the objects may be rotated, italicized, put in spherical (lens) projection... These 
distortions may also be blended.

• Select the two elements.
• Click on the Blend forms command of popup Attributes menu.
• Use horizontal scroll bar to specify the number of elements to generate.
• Activate the HLS checkbox to modify colors in each intermediate element using HLS (Hue, Light, 

Saturation) gradient. Otherwise, the colors will use RGB (Red, Green, Blue).



Paste Special dialog box

This dialog allows you to insert special format items from the clipboard.

The list can contain the following formats:
• NeoDraw: this format contains all specific NeoDraw graphic information; it is the default format used 

with the Paste command.
• Metafile: this is the Windows vector format.
• Bitmap: this is a common bitmap format generated by paint and image editors, such as Windows 

Paintbrush and NeoPaint.
• Bitmap DIB: this is a bitmap format for use with all resolutions (24 bits, 16 M colors only).
• Drive-Surface: a format generated by the program drvsurf.exe of Drive-Surface.

Voir: Preferences dialog box.



Fin de dialog




